How to grow healthy students
Everything you need to grow healthy students, from Apples to Zucchini

Table of Contents

Program Overview .................................................. 2
www.harvestofthemonth.com ............................. 3
Produce List and Criteria ................................. 4
Tool Kit Elements ................................................. 6
  Educator Newsletters ......................................... 6
  Taste Testing Tips ............................................... 7
  Family Newsletters ............................................. 8
  Menu Slicks ...................................................... 8
  Press Releases .................................................. 9
  Posters ............................................................ 9
  Links to California Content Standards ......... 9
Social Ecological Model .................................... 10
  Individual ....................................................... 10
  Interpersonal .................................................. 11
  Organizational ................................................ 12
  Community ....................................................... 13
  Policy .............................................................. 14
    Local School Wellness Policy .................. 15
Implementing Harvest of the Month .............. 16
  Getting Started ............................................... 16
  Ten Steps ........................................................ 17
  Gaining Support ................................................ 18
    Teachers, Administration, etc. ................ 19
    School Staff .................................................. 20
    Students ....................................................... 20
    Parents .......................................................... 21
    Retail ............................................................ 21
    Agricultural Community .......................... 21
  Training ........................................................... 22
    Harvest of the Month Site Coordinators ... 22
    Teachers, Child Nutrition Staff and Others 23
    Recommended Resources .......................... 23
  Connecting With The Community ............ 24
    Media ............................................................. 24
    Local Retail .................................................. 25
    5 a Day Campaign ....................................... 25
  Resources ......................................................... 26
    Nutrition Background Information ....... 27
  Ordering Information ...................................... 28
  Acknowledgements ............................................ 29
  Technical Support ............................................. 30
  CD Contents ..................................................... 32

Harvest of the Month was created for use by low-resource school districts that are part of the California Nutrition Network for Healthy, Active Families (Network), with funding provided by the U.S. Department of Agriculture’s Food Stamp Program. Development and oversight of Harvest of the Month are the responsibilities of the California Department of Health Services’ Cancer Prevention and Nutrition Section with support and guidance from the California Department of Education, as well as other curriculum specialists, educators, child nutrition staff, agricultural groups, agencies and organizations.

For a complete list of organizations, please refer to the Acknowledgements section on page 29 or the enclosed CD.
Program Overview

Purpose
After several years of varied local implementations, Harvest of the Month is being introduced and made available statewide with this tool kit. The overall goal of the tool kit is to provide knowledge- and skill-based strategies that are:

- standardized
- replicable
- cost-effective
- convenient

These strategies are designed to motivate and empower students to increase consumption and enjoyment of a variety of colorful fruits and vegetables and to engage in physical activity every day. This How to Grow Healthy Students booklet will help guide you to use the materials in this tool kit and implement a successful Harvest of the Month program.

Description
Studies show that healthy eating and daily physical activity have a profound impact on the body and mind by improving the ability to learn and comprehend, boosting energy, improving school attendance and changing attitudes, behavior and more. The tool kit provides materials and resources to support healthy food choices through increased access and consumption of fruits and vegetables, as well as daily physical activity. It uniquely supports core curricular areas through exploration and study. The tool kit presents a strategic opportunity to bring together the classroom, cafeteria, home and community to promote a common goal and healthier habits for students, especially those in low-resource schools.

The objective of the Harvest of the Month tool kit is for students to increase their:

- access to fruits and vegetables through school meal programs, classrooms, school gardens, farmers’ markets, grocery stores, community gardens, etc.
- preference for selected produce items through classroom activities, such as taste testing, cooking in class and school garden activities, and through menu offerings in the school meals program.
- participation in daily physical activity and understanding of why it is important.
- knowledge of and familiarity with California grown fruits and vegetables and the rich agricultural bounty of the State.
www.harvestofthemonth.com

The Harvest of the Month Web site, www.harvestofthemonth.com, enables educators, parents and the community to access and download existing and new materials as needed. Monthly updates will be made to the site that will allow users to share best practices, view additional recipe options, link to other online resources and submit comments or recommendations for improving future tool kit materials.

After several years of varied implementations, Harvest of the Month is being introduced and made available statewide as a tool kit. Harvest of the Month provides the tools and resources to give students hands-on opportunities to explore, taste and learn about the importance of eating fruits and vegetables.

The strength of Harvest of the Month lies in its ability to reach students in a variety of settings and where they are able to be most impacted — the classroom, cafeteria, home and community.

The success of Harvest of the Month depends on the people who implement it and work directly with the students to increase their knowledge of, access to and preference for fruits and vegetables and regular physical activity.

A successful program is a team effort. Key players in program implementation are classroom educators and child nutrition staff. Additional team members are other school staff, including the administration, students, parents and the local media and retail community. With a team in place, Harvest of the Month can be effectively implemented to motivate and empower students to increase consumption and enjoyment of a variety of colorful fruits and vegetables and engage in physical activity every day.

Harvest of the Month is designed to reach the Food Stamp eligible population and provides resources targeted to students, prekindergarten through 12th grade, and their families. There are four key elements in the tool kit. Additionally, a poster with the featured produce and other 5 a Day collateral are available to complement and extend messages.

Studies show that healthy eating and daily physical activity have a profound impact on the body and mind by improving the ability to learn and comprehend, boosting energy, improving school attendance and changing attitudes and behavior.
The Harvest of the Month tool kit is comprised of four key elements: educator newsletters, family newsletters, menu slicks and press releases. These elements are most effective when used together, but can be used separately in a variety of settings as part of a well-balanced, complete nutrition education program.

For more information on each element, please refer to the Tool Kit Elements section on page 6, the enclosed CD or www.harvestofthemonth.com.

In the first phase of this statewide launch, the tool kit features 12 California grown fruits and vegetables, one for each month beginning with September 2005. Subsequent phases will feature new 12-month cycles of California grown fruits and vegetables.

Following the Harvest of the Month Featured Produce cycle by the designated months is highly recommended. This will ensure consistency with local, regional and statewide efforts to promote Harvest of the Month with retailers, produce organizations, commodity boards and wholesalers. It will also more effectively saturate the Harvest of the Month message statewide – in the classroom and cafeteria, home and community.
The Harvest of the Month Featured Produce were selected based on the following criteria:

- California grown
- In season during month featured
- Represent a variety of colorful fruits and vegetables
- Familiar to children
- Affordable when purchased in season
- Align with the California 5 a Day Campaign
- Easy to use for classroom taste testing
- Recommended by school produce buyers for seasonal availability and cost

For a reproducible printout of the Harvest of the Month Featured Produce, please refer to the enclosed CD or www.harvestofthemonth.com.
The Harvest of the Month tool kit is comprised of four key elements, which can be complemented by a variety of other resources. Each element was developed using the Social Ecological Model as a framework and is intended for implementation in areas where nutrition education can make the biggest impact – classroom, cafeteria, home and the community. For more information on how the elements address the various levels of the Social Ecological Model, please refer to pages 8–13.

Each element can be downloaded from the enclosed CD or www.harvestofthemonth.com and personalized to add school/district names, logos and contact information. Samples of elements for the first month, Apples, have been included as inserts in this kit.

For more information on how to personalize the elements, please refer to the Technical Support section on pages 30–31 or the enclosed CD.

Educator Newsletters

Target User: Educators
Target Audience: Students, Pre-K – 12
Page Length: Four
Language: English

This monthly newsletter links to curricular areas such as mathematics, science, health, history-social science, English language arts and physical education. The educator newsletter provides key information about the featured produce, as well as resources to further explore each fruit and vegetable. It incorporates hands-on activities, tools and ideas for open-ended exploration by students and sample physical activities that support developmental skills such as listening, reflexes and hand-eye coordination. Although designed mainly for use by educators in the classroom, the newsletter is also a great tool to make available to child nutrition staff, librarians, nurses and others who might aid in the successful implementation of Harvest of the Month. Following are descriptions of the key newsletter sections:

- **Taste Testing:** Offers students the opportunity to experience the featured produce using their senses to help engage them in the learning process, and creates interest, awareness and support for increasing consumption of fruits and vegetables.

- **Cooking in Class:** Introduces students to enjoyable ways of incorporating the featured produce into their diet with a food preparation activity. The recipes are an easy and student-friendly way to encourage more fruit and vegetable consumption at home.

- **Nutrition Information:** Provides scientifically accurate nutrition information and health benefits of the featured produce. This section explains how fruits and vegetables come in a rainbow of colors and the importance of eating a variety of colorful fruits and vegetables every day – red, yellow/orange, white, green and blue/purple. It also provides examples of fruits and vegetables within each color group.

- **Interesting Facts:** Highlights fun and novel facts about the featured produce to help keep students engaged.
- **Student Sleuths**: Provides learning opportunities for students to further explore facts about the featured produce and utilize research, data collecting and reporting skills. (Answers are provided on the enclosed CD.)
- **Botanical and Growing Information**: Presents scientific and botanical information on the featured fruit or vegetable.
- **History**: Offers a general overview and historical timeline of the featured produce. It includes the history, origin and migration into California’s agricultural industry.
- **Home Grown Facts**: Provides information on the growing region and commercial production of the featured produce in California.
- **School Garden**: Features hands-on activities for students to connect to agriculture and science that can be carried out in the classroom or school garden.
- **Cafeteria Connections**: Offers strategies to utilize the cafeteria as a learning laboratory and to work with child nutrition staff.
- **Physical Activity Corner**: Provides teachers with activities for students to support physical activity while developing sensory and motor skills. Key physical education issues, events and dates are highlighted.
- **Adventurous Activities**: Offers fun, hands-on activities for students to experience and explore featured produce through science, history, math, writing, field trips and monthly events.
- **Literature Links**: Suggests literature specific to the featured produce, agriculture and nutrition across all grade levels to complement the *Harvest of the Month* activities.
- **Student Advocates**: Offers strategies for students to develop their leadership skills by educating others, including the media, about the featured produce and proactively involving the community in *Harvest of the Month* activities. It links to the community through retail stores, farmers’ markets and more.
- **Up Next**: Announces next month’s *Harvest of the Month* Featured Produce.
- **Links to California Content Standards (inserts)**: Demonstrates ways educators can make connections to core curricular areas by implementing various *Harvest of the Month* activities. For more information on the Standards, please refer to the enclosed inserts or page 9.

### Taste Testing Tips
- Check district policy on storage and handling procedures.
- If food is not allowed in the classroom, conduct taste testing in the cafeteria.
- For tips on taste testing activities, refer to School Foodservice Guide – Successful Implementation Models for Increased Fruit and Vegetable Consumption, page 39-40; Kids Cook Farm-Fresh Food; Fruits and Vegetables Galore; and the Power Play! School Idea and Resource Kit. The enclosed CD contains some of these materials.
- The California Children’s 5 a Day—Power Play! Campaign offers a variety of materials, as well as training and technical assistance, to teachers and youth leaders working with 9- to 11-year-old children from Food Stamp eligible families. Each county within California is served by one of eleven funded regional lead agencies. To find out the contact information for your region’s lead agency or to obtain more information about the Campaign, please visit [www.ca5aday.com](http://www.ca5aday.com) or call 1-888-EAT-FIVE.

For information on ordering the above resources, please refer to page 28.
Family Newsletters

Target User: Educators, Project Coordinators
Target Audience: Parents
Page Length: One
Language: English and Spanish

The family newsletter takes Harvest of the Month from school to the home, allowing students and their families to share the experience. Each newsletter includes:

- General information on how nutrition affects a child’s health and education.
- Tips for providing more fruits and vegetables and ways to encourage healthy food choices.
- A recipe for the Harvest of the Month featured fruit or vegetable.
- Ideas for engaging in physical activity.
- Tips for selecting, storing and serving the featured produce item.

Menu Slicks

Target User: Child Nutrition Staff
Target Audience: Students, K – 5
Page Length: One, Front and Back
Language: English

The two-sided menu slick is designed to provide child nutrition staff with a template for inserting the monthly school breakfast and/or lunch menu. Each menu slick includes:

- Activities with the featured produce that test memory and motor skills.
- Activities that reinforce what students learn in the classroom.
- Information on health benefits of the different color groups and examples of fruits and vegetables within each group.
- Nutrition information for the featured produce.
- Activities that encourage students to look over the menu and eat the school meals.

CD

The Harvest of the Month tool kit includes a CD containing electronic files for all monthly elements, as well as additional resources to help with program implementation.

For a complete listing of CD contents, please refer to page 32.
Press Releases

Target User: Media Liaisons, Project Coordinators
Target Audience: Media, Community, Retail, Families
Page Length: Two
Language: English and Spanish

Each press release is a template that provides districts with the opportunity to share the Harvest of the Month activities that different schools are doing in and out of the classroom. It also encourages community participation. In addition to community distribution, press releases can be posted on the district or school Web site, sent home to parents, or dropped into existing community and school newsletters. Each press release includes:

- Nutrition information and background on Harvest of the Month and the featured produce.
- Dedicated sections for each district to insert their own local information to personalize and tailor the press release for their community.
- Statistics on how the Harvest of the Month Featured Produce support California agriculture.

Posters

Target User: Educators, Child Nutrition Staff
Target Audience: Students, Pre-K – 12
Page Length: One
Language: English

For each 12-month cycle, a 24 x 36” poster provides a visual display of the Harvest of the Month Featured Produce and is available to order from the Network. An 8.5 x 11” sample is provided as an insert in this tool kit. Please refer to www.harvestofthemonth.com for poster release information for Cycles II and III. The posters include:

- English and Spanish names of the featured produce.
- A brief list of health benefits of the color groups and examples of fruits and vegetables within each group.

Please refer to the Ordering Information section on page 28, the enclosed CD or www.harvestofthemonth.com.

Links to California Content Standards

Harvest of the Month was developed to support educators in teaching students to develop healthy eating and physical activity habits and link to a variety of curricular areas. The Links highlight how Harvest of the Month supports curricular areas of health, physical education, English language arts, science, history-social science and mathematics. Select state-adopted standards are included for kindergarten through grade 12. Links to California Content Standards, and other appropriate guidelines, are enclosed as inserts in this tool kit, as well as on the CD. They can also be found at www.harvestofthemonth.com. Links are available for the following grade levels:

- Prekindergarten
- 6 – 8 (middle school)
- K – 2
- 9 – 12 (high school)
- 3 – 5
The Network’s three main goals are to:
- increase the consumption of fruits and vegetables;
- promote physical activity; and
- promote the utilization of federal nutrition assistance programs.

Recognizing that low-income California families live in a dynamic, physical, social and cultural environment that in turn influences individual behavior, the Network has adopted the Social Ecological Model as its theoretical framework. The model assumes that appropriate changes in the social environment will produce changes in the individual, and that the support of the informed individuals in the population is essential for implementing environmental changes. The five levels of the model are addressed within the **Harvest of the Month** elements.

### Individual

*This level includes individual characteristics that influence behavior, such as knowledge, attitudes, beliefs, personality traits and skills.*

#### Educator Newsletters:
- Develop students’ skills for incorporating more fruits and vegetables into their daily meals and provide them with an opportunity to try new foods through taste testing and classroom cooking activities.
- Increase students’ knowledge and preferences for fruits and vegetables by providing hands-on and experiential activities (e.g., taste testings; field trips to farmers’ markets, local farms and grocery stores; and participation in the school garden activities).
- Promote opportunities for physical activity in the classroom and increase students’ knowledge about the importance of engaging in physical activity every day.

#### Menu Slicks:
- Provide additional opportunities for child nutrition staff to promote the featured produce item and school meals to both students and their families.

#### Posters:
- Reinforce the **Harvest of the Month** message in the classroom, cafeteria and other high-traffic areas.
Interpersonal

This level includes interpersonal processes and primary groups (e.g., parents, family, peers, social networks, associations) that provide social identity and role definition.

Educator Newsletters:
- Provide information to expand teachers’ knowledge of the featured fruit or vegetable and increase confidence in teaching Harvest of the Month concepts to their students. Teachers implementing Harvest of the Month in the classroom also act as role models for their students.
- Support educators with classroom learning ideas that promote exploration of the featured produce including hands-on experiences to increase fruit and vegetable consumption.
- Provide a socially normative setting in the classroom by having students learn about and taste test fruits and vegetables.
- Promote new group activities for students, such as physical activity in the classroom and improve peer norms related to engaging in physical activity every day.

Menu Sticks:
- Provide students a chance to apply their knowledge and skills about fruits and vegetables when making food choices in and out of the cafeteria.
- Enable Child Nutrition Program to reinforce healthy eating messages and promote healthy food choices.
- Create the opportunity for the child nutrition staff to have a positive influence on children’s eating habits and be recognized by parents and teachers as a vital part of the school community.

Family Newsletters:
- Provide information to increase parents’ knowledge of the featured produce and preparation options to enhance their own preferences for fruits and vegetables. In turn, parents act as role models by serving more fruits and vegetables and engaging in physical activity with their children.
- Provide easy and affordable recipes and options to encourage and empower parents to support children’s healthy eating habits while encouraging physical activity.
- Promote participation in school meal programs as an affordable option for parents to ensure their children get the recommended amount of fruits and vegetables every day.
- Inform parents of additional school activities (e.g., National School Lunch Week, Walk to School Week, 5 A Day Month) and provide opportunities to get involved.

Press Releases:
- Offer effective messaging to parents and other community members about nutrition and featured fruits and vegetables and physical activity.

Other Activities:
- Schedule regular development and in-service training to provide the opportunity for project coordinators, teachers and staff to further develop their knowledge and skills while becoming more informed about fruits and vegetables, physical activity and nutrition.
- Establish student Nutrition Advisory Committees (NACs) to work with the child nutrition staff. For example:
  - Promote increased variety of fruits and vegetables (e.g., create or expand the salad bar, provide fresh produce on the cafeteria menu and vary the types of produce offered).
  - Identity students’ preferences for various produce options.
  - Participate in making changes in cafeteria menus, snack bar and vending choices.
Social Ecological Model (continued)

Organizational
This level includes institutional factors that operate within organizations (e.g., schools, worksites, religious groups, etc.) such as rules, regulations, policies and informal structures.

Educator Newsletters:
- Increase awareness and participation of teachers and staff in working together to coordinate activities and promote consistent messages.
- Provide ongoing opportunities to reinforce preferences and build skills through regular taste testing, classroom food demonstrations, and preparation. Promote the use of classroom cooking carts.
- Promote nutrition education in classrooms, school gardens, assemblies, cafeteria, after school programs and through parent/community outreach opportunities.

Menu Sticks:
- Demonstrate the school’s commitment to promoting students’ health and providing a vehicle to communicate to families the benefits of school meal programs.

Family Newsletters:
- Provide an additional vehicle to communicate to families the benefits of participating in school meal programs, Harvest of the Month messaging, events, actions school/district has taken to enhance school meals and demonstrate the school’s priorities regarding health.

Press Releases:
- Highlight and educate the community on changes in the school environment as a result of Harvest of the Month. This could include:
  - Offering additional fruits and vegetables in salad bars, vending machines and snack bars.
  - Promoting Farm to School implementation and school gardens for hands-on activities.
  - Encouraging healthy fundraisers or providing alternative ideas for fundraiser products (i.e., selling fruit baskets instead of cookies).
Community

This level includes social networks, norms, standards (e.g., public agenda, media agenda) that exist within a community.

Educator Newsletters:
- Prompt teachers and students to become advocates for health through partnerships with local grocery stores, restaurants, farmers, community groups, hospitals, nursing homes and community gardens. Partnerships enhance the Harvest of the Month efforts through donations, displaying posters, offering taste testings and aligning produce advertisements to coincide with Harvest of the Month featured fruits or vegetables.
- Enable teachers to apply the information outside of school in the community. For example, recommend healthy products for church fundraisers, provide healthy snacks at students’ soccer games or start a walking group with co-workers.
- Enable teachers to influence policies in schools to improve the quality and increase the availability of produce.
- Inform and instruct teachers and other school staff through in-service training.
- Involve students with electronic (television, radio) media to promote healthy eating and physical activity in fun, creative ways, including on-air promotions, live remotes, feature stories, regular news segments and public affairs programming.

Family Newsletters:
- Enable parents and families to apply the information outside of the home in the community and support businesses and organizations that promote these healthy choices. For example, prepare healthy dishes for neighborhood functions, organize a walking group or suggest positive changes to support Harvest of the Month at PTA/PTO meetings.
- Promote opportunities for parents to mentor students during and after school and in other recreational outlets (e.g., soccer, basketball, dance).

Press Releases:
- Provide a medium for families, business owners, school and community leaders, as well as individual community members to receive and relay information such as events, activities, and plans to encourage community participation.
- Provide background information and how to get involved with various Harvest of the Month school and community activities.
- Encourage partnerships with local retailers, such as grocery stores, to enhance Harvest of the Month efforts through donations, by displaying posters, or by aligning produce advertisements and promotions to coincide with the Harvest of the Month featured fruit or vegetable.
- Increase community awareness through articles, public service announcement scripts and media coverage from local events where Harvest of the Month is part of the highlighted activities. These events can be part of national efforts such as National 5 A Day Month (September), National School Lunch Week (October), Walk to School Week (October), National Nutrition Month (March) and Spring into Health (April). Smaller events that may be utilized to leverage media include Back to School nights, open house and family literacy nights.
Social Ecological Model (continued)

Community (continued)

Other Activities:

- Promote opportunities to further disseminate the Harvest of the Month message and incorporate the community into the program. Some media include:
  - Newspaper
  - Electronic
  - Billboard
  - Signage in stores (help create the connection between the school and the community)

Policy

This level includes local, state and federal policies and laws that regulate or support individual behavior.

Educator Newsletters:

- Prompt students through ongoing advocacy activities to engage in the process of assessing and identifying needs and potential areas for policy development.
- Empower teachers and other school staff to present valid arguments for policy change and implementation by providing sound information on the impact of health on students’ academic achievement and on ways to sustain healthy eating and physical activity practices. (e.g., provide healthy foods and drinks in vending machines, add a salad bar to the cafeteria, etc.)
Family Newsletters:
- Reinforce existing policy to maintain a healthy school nutrition environment by advertising the availability of salad bars and instructional gardens on every school campus as part of the implementation of a district wide Farm to School program.
- Provide families with information and opportunity to participate in the school policy formation, implementation and evaluation.

Menu Slicks:
- Demonstrate the district’s commitment to supporting child nutrition programs and policies for providing a healthy, supportive and educational environment.

Press Releases:
- Demonstrate to the community the district’s commitment to supporting child nutrition programs and policies for providing a healthy, supportive and educational environment.
- Encourage the community to support Harvest of the Month and, ultimately, school policy. This could also be a potential vehicle to encourage community involvement in advocating policy development.
- Show collaborative effort with other organizations in the development, implementation and/or maintenance of the policy.

The Local School Wellness Policy
- Harvest of the Month may assist school districts in implementing Public Law 108-265, Section 204 of the Child Nutrition and WIC Reauthorization Act of 2004, which requires school districts that participate in the National School Lunch and/or Breakfast Program to establish a local school wellness policy.
- Working with Child Nutrition Program professionals to promote the Harvest of the Month. Featured Produce may also help districts to meet these guidelines.

For more information on the Local School Wellness Policy, please visit:
www.fns.usda.gov/tn/Healthy/wellnesspolicy.html
www.californiahealthykids.org
Implementing Harvest of the Month

Getting Started

A successful Harvest of the Month program is a team effort. The strength of Harvest of the Month lies in its ability to reach students in a variety of settings and where they are able to be most impacted—the classroom, cafeteria, home and community. The success of your Harvest of the Month program depends on the people who implement it and the staff who work directly with the students to increase their knowledge of, access to and preference for fruits and vegetables and regular physical activity.

Key players in implementing Harvest of the Month are classroom educators and child nutrition staff. Additional team members to engage are other school staff, including the administration, students and parents. With a team in place, you can more effectively implement Harvest of the Month and motivate and empower students to increase consumption and enjoyment of a variety of colorful fruits and vegetables and engage in physical activity every day.

10 Steps to Implement Harvest of the Month

There are a variety of ways to launch Harvest of the Month. The following ten steps will help guide you through the general process of planning and implementing a successful program.*

1. **Gather support within the school community.**
   Meet with key players—teachers, child nutrition staff, administrators, school board members, school staff, students and parents—to introduce Harvest of the Month. Engage them and solicit ideas for planning and implementing a program in their school/district. For more information, please refer to the Gaining Support Within The School Community section on page 18, the enclosed CD or www.harvestofthemonth.com.

2. **Coordinate with the Child Nutrition Program.**
   Meet with the Child Nutrition Director to discuss and determine her/his level of interest in participating. Review and finalize the Harvest of the Month Featured Produce list for the upcoming school year. For information on the Harvest of the Month Featured Produce, please refer to page 5 in this guide, the enclosed CD or www.harvestofthemonth.com. As needed, determine the logistics for classroom orders and delivery of the featured produce to the classroom for taste testing activities (e.g., classroom allocation and distribution, amount needed, bulk delivery schedule).

3. **Identify Harvest of the Month Site Coordinators.**
   After introducing Harvest of the Month, identify a lead teacher or child nutrition staff who will coordinate and oversee implementation at each school site.

4. **Coordinate with regional 5 a Day Campaigns.**
   Contact your Regional Nutrition Network Project Director to find out more about how to connect with the 5 a Day Campaigns in your region. For a complete list of Regional Nutrition Networks Project Directors, please refer to the enclosed CD or visit www.dhs.ca.gov/ps/cdic/cpns/network/mn.htm.
5. **Conduct training for Harvest of the Month Site Coordinators.**

   Before the school year begins, provide an orientation for Site Coordinators on the tool kit elements and develop a distribution process. Also discuss the distribution of the featured produce as agreed in step two with the Child Nutrition Director.

   *For more information, please refer to the Training section on page 22, the enclosed CD or www.harvestofthemonth.com.*

6. **Conduct training for teachers, child nutrition staff and others.**

   After training the Site Coordinators, provide an orientation for all teachers, child nutrition staff and others who will use the tool kit elements.

   *For more information, please refer to the Training section on page 22, the enclosed CD or www.harvestofthemonth.com.*

7. **Personalize and print Harvest of the Month tool kit materials.**

   Personalize and print the monthly educator newsletters, family newsletters, menu slicks and press releases.

   *For information on how to personalize Harvest of the Month elements, please refer to the Technical Support section on pages 30-31 or the enclosed CD.*

8. **Order Harvest of the Month posters and other 5 a Day collateral and resources.**

   Determine what materials and resources to order for participating schools. These include the Harvest of the Month Featured Produce posters; 5 a Day collateral; and other resources such as USDA’s Fruits and Vegetables Galore, CDE’s Kids Cook Farm-Fresh Food and Fresh Fruit and Vegetable Photo Cards, and the Produce for Better Health Foundation’s School Foodservice Guide – Successful Implementation Tips for Increasing Fruit and Vegetable Consumption.

   *Please refer to the Resources and Ordering Information sections on pages 26-28, the enclosed CD or www.harvestofthemonth.com.*

9. **Distribute Harvest of the Month materials and resources.**

   Coordinate distribution of tool kit elements and resources as agreed to with the Site Coordinators in step five.

10. **Provide ongoing support and solicit feedback.**

    Present updates regularly at staff and faculty meetings to continue the promotion of and support for Harvest of the Month. Solicit feedback on successes and problems, as well as ideas for improvement.

*These steps represent a compilation of recommended practices from several districts and may be adapted to meet your district’s needs.*
Gaining Support Within The School Community

Everyone within the school community plays a role in encouraging healthy eating habits and regular physical activity. The support and involvement of the child nutrition staff is vital to the success of Harvest of the Month. By involving others in the process, you can gain program support, which will lead to a more successful implementation. In addition to distributing the Harvest of the Month Fact Sheet* as a general program overview, arrange time to meet with other key members in the school community to discuss ways in which they would like to become involved and how they can support the messages being promoted by Harvest of the Month.

The following are some suggestions to involve others within the school community, including: teachers, principals, superintendents and school boards; school staff; students; parents; retailers; and the agricultural community.

*Two Harvest of the Month Fact Sheets were developed for distribution – a local and a state version. For more information on distribution of the Fact Sheets, please refer to the enclosed CD or www.harvestofthemonth.com.
Strategies to Involve Teachers, Principals, Superintendents and School Boards

- Discuss the need for nutrition education and give examples of how healthy eating has been linked to improved test scores, reduced absenteeism and better classroom behavior.
- Demonstrate how incorporation of Harvest of the Month supports the new federal requirement for establishing a Local School Wellness Policy and will assist them in meeting several aspects of this requirement. Use specific examples such as the Links to California Content Standards and highlight sections of the educator newsletter.
- Emphasize that the Harvest of the Month physical activity component prepares students for the state-administered Physical Fitness Test, the FITNESSGRAM®.
- Describe how the tool kit is turnkey, allows for flexibility and provides teachers and child nutrition staff with the tools and links to California Content Standards.
- Schedule a presentation for an upcoming meeting (board, staff, faculty, etc.). Share the tool kit elements, describe the program and hold a Q&A session. Consider inviting students, parents, teachers and child nutrition staff to present the benefits of Harvest of the Month from their perspectives.

In addition to these suggestions, the following are additional examples of how to engage teachers and school administrators.

**Teachers:**
- Provide a taste testing demonstration to show how the Harvest of the Month Featured Produce can be used in a classroom.
- Highlight other available Network resources for site staff, such as the educator and family newsletters, suggested classroom activities, books and other free resources.

For additional resources, please refer to the Resources section on pages 26-27, the enclosed CD or www.harvestofthemonth.com.

**School Administrators (School Board, Superintendent and Principals):**
- Share stories of districts that have received positive media attention regarding Harvest of the Month and how these districts were seen by the community for addressing the prevention of childhood obesity.
- Invite them to eat a healthy breakfast or lunch with students, work in the school garden and/or participate in a Harvest of the Month classroom activity.
Gaining Support Within The School Community (continued)

**Strategies to Involve School Staff**

Includes school nurses, librarians, physical education teachers and specialists, life skills and foods/nutrition teachers, and afterschool program staff.

- Discuss possible ways to promote Harvest of the Month on the school campus (nurses’ office, library, gymnasium, computer lab, etc.).
- Distribute the educator and family newsletters and encourage them to adapt the lessons and activities for their purposes.
- Solicit their ideas for and involvement in staff development and in-service training opportunities.
- Discuss ways in which older students may assist in program implementation at lower grade levels.
- Invite them to participate by offering taste tests as part of their work with students.
- Share Harvest of the Month collateral (e.g., Featured Produce posters, California 5 a Day resources, Fresh Fruit and Vegetable Photo Cards).
- Discuss challenges they face in promoting healthy food choices and physical activity.
- Invite them to implement their own activities. For example, if the school has a garden, discuss ways to engage students in garden-based nutrition education.

**Strategies To Involve Students**

- Schedule meetings with student leaders (e.g., student councils/governments, school health councils, student nutrition advisory committees) and other students to introduce them to Harvest of the Month.
- Solicit their ideas on how to best implement the program on campus.
- Engage students in the opportunity to make a difference in their schools by expressing their ideas and having them work with the appropriate adult to implement them.
- Encourage students to involve their teachers and child nutrition staff to implement changes in the school environment, such as:
  - increasing access to fruits and vegetables in the cafeteria (e.g., salad bar), vending machines and snack bars;
  - starting or maintaining a school garden; and
  - improving access to school grounds and/or increasing opportunities for more physical activity.

**Evaluation**

As with any new program, it is important to evaluate the impact of the work and, if necessary, make appropriate modifications. The Harvest of the Month Web site has survey tools that can be used to measure change in factors that influence fruit and vegetable consumption. The Web site also has resources that describe how to measure change and assess impact. It is highly recommended that these tools be used to assess the impact of your program. Having an evaluation and results may help you to gain support of members within the school community.
Strategies To Involve Parents

As gatekeepers to the home, parents are key in implementing a successful program.

- Conduct parent workshop sessions at Back to School Nights and other parent meetings.
- Emphasize the link between nutrition and improved academic performance and classroom behavior.
- Invite them to share their experiences and skills in gardening or food preparation and their ideas for family physical activity. Parents can even share these experiences and ideas in the classroom.
- Invite them to volunteer in the classroom on taste testing days or to chaperone on field trips.
- Provide them with the family newsletters. Encourage parents to share these with friends and neighbors.

Strategies To Involve Retail

Before you begin, it is recommended that you contact your regional 5 a Day coordinator to see which stores in your area currently work with the California Nutrition Network and California 5 a Day Retail Program. This will help eliminate any duplication of effort or confusion about the various activities.

- Contact the store or produce manager to arrange a meeting or presentation.
- Provide the store or produce manager with a copy of the Overview for Retailers. (For more information, please see the Resources section on the CD or visit the Web site.
- Discuss ways in which they would like to get involved in Harvest of the Month. Be sensitive to the retailer’s own business challenges by trying to create a “win-win” situation for everyone.

Strategies To Involve The Agricultural Community

Support from the agricultural community extends Harvest of the Month messages and enriches students’ experiences with fruits and vegetables. It also presents expanded opportunities for students to learn about California agriculture.

- Use the California Commodity Boards as a resource. Visit www.cdfa.ca.gov/mkt/mkt/mktbrds.html.
- Meet with local farmers, produce vendors and Master Gardeners and discuss ways in which they would like to get involved with Harvest of the Month. Examples may include classroom presentations on farming, horticulture and marketing.
- Arrange field trips and other special promotions with local farmers’ markets or farms. To find information about local farmers’ markets and farms in your area, visit www.localharvest.org.
- Discuss with your district’s vocational agricultural teachers and/or your local Agriculture in the Classroom Ambassador about how to enrich students’ learning of the state’s agriculture and its role in the economy.
Successful implementation of Harvest of the Month requires thorough training of all those who will be working with the tool kit elements and who may be involved in implementing the activities throughout the school community. The following are some tips to conduct training sessions for these integral members of your team, beginning with the Harvest of the Month Site Coordinators.

**Harvest of the Month Site Coordinators**

The Site Coordinator’s primary responsibility is to execute Harvest of the Month at her/his school site. This person may be a teacher or other member of the school staff willing to work and communicate with all school staff. The Site Coordinator is the main point-of-contact and should be a leader who oversees the site-level implementation of Harvest of the Month.

Depending on how Harvest of the Month is set up in your district, a Site Coordinator can be the person who distributes the tool kit elements to participating school staff; coordinates with teachers using the educator newsletters; works with child nutrition staff to determine produce needs for taste testing and/or classroom cooking activities; identifies needs for posters and other resources; and/or oversees any other activities related to Harvest of the Month. Therefore, it is critical that Site Coordinators have a thorough training and knowledge of the tool kit elements and the overall purpose of the program.

**Tips and Topics to Discuss:**

- Review the four key tool kit elements and share samples of each. (Elements for the first month, Apples, have been included as inserts in this kit.)
- Determine the process, including step-by-step instructions, on how to order and distribute materials, including the monthly elements, produce, posters and other Harvest of the Month-related items.
- Discuss how Site Coordinators can help initiate communication or follow-up with teachers, child nutrition staff, school administration, nurses, librarians and any other school staff about Harvest of the Month. Discuss ideas on how to best gain support from the school community and how to involve them in the program.

  *For more ideas, please refer to the Gaining Support section on pages 18-21.*

- Discuss the best ways to communicate and connect with school staff for successful program implementation. Examples may include giving presentations at staff meetings or at regularly scheduled Harvest of the Month meetings.
- Share tips for taste testing in the classroom, linking to literature, integrating physical activity and strategies for working with parents and other volunteers.
- Review proper food safety and handling techniques.
Teachers, Child Nutrition Staff and Others

A successful program requires the support of the entire school community. This support system will help create a well-rounded program and reinforce the goal of Harvest of the Month to motivate and empower students to make healthy choices.

After orienting the Site Coordinators, a general orientation should be conducted for all teachers, child nutrition and other school staff who will be participating in the program. By bringing these players together, it will reinforce the idea of a team effort to successfully implement Harvest of the Month. You may even want to have the Site Coordinators assist with the orientation. This will help build their leadership skills and develop their knowledge of the program.

Tips and Topics to Discuss:

- Conduct an orientation before the start of the upcoming school year. Distribute the agreed to Harvest of the Month Featured Produce list for the year.
- Review the tool kit elements and discuss how they can be used.
- Define the roles and responsibilities of each team member and discuss how each person plays an integral part in implementing Harvest of the Month.
- Discuss the process of including the monthly featured produce item in school meals.
- Discuss ways in which various team members can reinforce the Harvest of the Month message and the lessons learned by students. Examples may include:
  - Teachers can encourage students to bring the school menu home to share with family members.
  - Librarians can select books about the Harvest of the Month Featured Produce for students to read.
  - Child nutrition staff can coordinate Harvest of the Month marketing and promotions in the cafeteria.
  - School staff can display the Harvest of the Month poster in their classrooms and offices.
  - Parent groups can be asked to promote the featured produce for fund-raising activities.

Recommended Harvest of the Month Resources

During training, encourage both Site Coordinators and participating staff to use the resources recommended in the Resources section on pages 26-27, on the enclosed CD or www.harvestofthemonth.com.

The following resources are referenced in each month’s educator newsletter:

- Fresh Fruit and Vegetable Photo Cards
  California Department of Education, 1997
- Fruits and Vegetables Galore
  United States Department of Agriculture, 2004
- Kids Cook Farm-Fresh Food
  California Department of Education, 2002
- School Foodservice Guide – Successful Implementation Models for Increased Fruit and Vegetable Consumption
  Produce for Better Health Foundation, 2005

To order these resources, please refer to page 28, the enclosed CD or www.harvestofthemonth.com.
Connecting With The Community

The Network and California 5 a Day Campaign are working with the commodity boards and other agricultural organizations to develop statewide partnerships for promoting Harvest of the Month. At a regional level, there are a variety of outlets for extending the program. Connecting with local media, retailers and the regional 5 a Day campaigns are important areas where you can extend the Harvest of the Month message into the community.

Connect with Media

Get the media and community involved with Harvest of the Month events and activities. The tool kit contains press release templates for each of the month’s featured produce items and an overall program overview. Each template can be tailored specifically for your school district. Training is available for Network-funded partners. Contact your Program Manager for details.

- Contact your school district to find out if they have a Public Information Officer or a Public Affairs department. If so, contact the appropriate person for suggestions, tips and steps to connect with the media.
- Develop a media list of local newspapers (daily, weekly, community and ethnic publications), television and radio outlets.
- Customize the press release to highlight specific Harvest of the Month events or activities. The release should include name of contact person, title, address, phone and fax numbers and e-mail address for the person handling your district’s press.
- Send press releases by e-mail or fax. Accompany the releases with fact sheets, local statistics and other information about your district and even specific schools.
- Call reporters and let them know about Harvest of the Month events and activities. If you do not know whom to contact, ask for the editorial assistant or news desk and ask them to direct you to the appropriate contact.
- Be sure to have signed parental permission slips if students are going to be interviewed or photographed.
- Describe your activities and invite media to film or photograph students participating. Think about visuals and newsworthiness when pitching to television or print photographers.
- Capitalize on existing national and state events, like Walk to School Week and National Nutrition Month.
- Get permission from the principal, administrators and public information officers as appropriate.
- Be a resource for the media. Develop an ongoing relationship with local media.
Connect with Local Retail

A retail component can help strengthen your program. Retailers can get involved in a variety of ways by offering hands-on and experiential activities and further increasing students’ knowledge, access to and preferences for fruits and vegetables.

The tool kit elements include a range of resources that can be easily adopted and provided to participating retailers. Examples include recipes, taste testing activities, nutrition information and even the poster. Additionally, the Harvest of the Month Featured Produce are aligned with the 5 a Day Retail Program’s Express Lane Tours.

Opportunities for Retailer Participation:

- Conduct in-store taste testing, which creates an opportunity to try the Harvest of the Month Featured Produce.
- Offer grocery store tours of the produce section and back-of-the-house preparation areas.
- Promote the Harvest of the Month Featured Produce in store by displaying the poster and including educational messages in promotional activities, samplings or displays.
- Align store advertising to include the Harvest of the Month Featured Produce.
- Support child health with messages in advertising and sales circulars about the importance of fruits and vegetables.
- Provide artwork for coupons that can be distributed with in the family newsletters.
- Issue press releases or post information on store Web site indicating that the store is a participant in Harvest of the Month.
- Donate featured produce for classroom activities.

Connect with California 5 a Day Campaign

The California 5 a Day—for Better Health! Campaign, as part of the Network, works with regional, state and national partners to build healthy communities. Included in this Campaign are:

- California African American 5 a Day Campaign
- California Children’s 5 a Day—Power Play! Campaign
- California 5 a Day—Be Active! Worksite Program
- California 5 a Day Retail Program
- California Latino 5 a Day Campaign

Partnering with your regional 5 a Day Campaigns will complement your program by providing more resources and allowing you to deliver the Harvest of the Month message to specific audiences. It will also bring in more support for Harvest of the Month and enhance everyone’s efforts to motivate and empower students to make healthy choices.

If you have questions or would like more information, contact the California 5 a Day Retail Program for guidance (E-mail: 5aDayRetail@dhs.ca.gov).

To learn more about the 5 a Day Campaigns in your region, contact your Regional Nutrition Network Project Director. For a contact list, please refer to the enclosed CD or visit: www.dhs.ca.gov/ps/cdic/cpns/network/rnn.htm
Resources

There are a wide variety of resources available to complement the tool kit elements. Below are some examples of the resources used in the development of the tool kit and others that are readily available.

Please visit www.harvestofthemonth.com for a complete listing of all resources.

Agriculture:
California Farm Service Agency
www.fsa.usda.gov/ca
California Foundation for Agriculture in the Classroom
www.cfaic.org
California Grown Campaign
www.caliorniagrown.org
California Rare Fruit Growers
www.crfg.org
California Tree Fruit Agreement
www.eatcaliforniafruit.com
Local Farmers’ Markets and Farms
www.localharvest.org
United Fresh Fruit and Vegetable Association
www.uftva.org
Western Growers Association
www.wga.com

Government Agencies:
California Department of Education
www.cde.ca.gov
Curriculum and Instruction
www.cde.ca.gov/ci/
Educational Resources Catalog
www.cde.ca.gov/re/pn/rc/
Includes resources such as:
Fresh Fruit and Vegetable Photo Cards, 1997
Kids Cook Farm-Fresh Food, 2002
Learning Support
www.cde.ca.gov/ls/
Nutrition Services Division
www.cde.ca.gov/ls/nu/
Prekindergarten Learning & Development Guidelines, 2000
www.cde.ca.gov/sp/cd/re/prekguide.asp
California Department of Food and Agriculture
www.cdfa.ca.gov
California Department of Health Services
www.dhs.ca.gov
Cancer Prevention and Nutrition Section
California 5 a Day – for Better Health! Campaign
www.ca5aday.com
Project LEAN
www.caliorniaprojectlean.org
California Healthy Kids Resource Center
www.caliorniahealthykids.org
California Integrated Waste Management Board
www.ciwmmb.ca.gov
United States Department of Agriculture
www.usda.gov
Food Stamp Nutrition Connection
www.nal.usda.gov/food stamp/
Team Nutrition
www.fns.usda.gov/tn
Includes resources such as:
Fruits and Vegetables Galore, 2004
The Power of Choice, 2003
Nibbles for Health, 2002
USDA for Kids
United States Department of Defense
Fresh Fruit and Vegetable Program
www.dscp.dla.mil
United States Department of Health and Human Services
Centers for Disease Control and Prevention
www.cdc.gov
University of California – Cooperative Extension
Expanded Food and Nutrition Education Program
http://efnep.ucdavis.edu
Food Stamp Nutrition Education Program
http://fnenep.ucdavis.edu
Master Gardener Program
www.mastergardeners.org
Junior Master Gardener Program
http://ca4h.org/projresource/jrgardener/
Associations and Foundations:
American Dietetic Association  
www.eatright.org
CANFit (California Adolescent Nutrition and Fitness) Program  
www.canfit.org
National 5 A Day/Produce for Better Health Foundation  
www.5aday.com
School Foodservice Guide – Successful Implementation Models for Increased Fruit and Vegetable Consumption, 2005
School Nutrition Association  
www.schoolnutrition.org

Physical Activity:
Kidnetic  
www.kidnetic.com
Sports, Play & Recreation for Kids  
www.sparkpe.org/index.jsp
Verb Now  
www.verbnow.com

School Gardens:
Kids Gardening  
www.kidsgardening.com
Life Lab  
www.lifelab.org
Project Food, Land & People  
www.foodlandpeople.org

Nutrition Background Information
The USDA released the new food guidance system “Steps to a Healthier You” in January 2005. MyPyramid, which replaces the previous Food Guide Pyramid, is part of an overall food guidance system that emphasizes the need for a more individualized approach to improving diet and lifestyle. MyPyramid incorporates recommendations from the 2005 Dietary Guidelines for Americans.

Note: To ease children’s understanding of the Dietary Guidelines for Americans, some information in this tool kit has been simplified. The USDA recommends that 1 cup of lettuce count as only 1/2 cup of vegetables and that 1/4 cup of dried fruit count as 1/2 cup of fruit. In addition, the USDA’s MyPyramid Web site provides specific examples of the cup measurements of various whole fruits and vegetables. For simplification, the tool kit elements do not provide this level of detail and make the more general recommendations as used in the menu slicks.

For more information, please visit:
www.mypyramid.gov/kids/index.html

Please note that www.mypyramid.com is a spoof Web site and unrelated to the official government site, www.mypyramid.gov
Ordering Information

**Harvest of the Month Poster & Other Collateral**

Network-funded partners can order the Harvest of the Month posters and other collateral items by visiting [www.harvestofthemonth.com](http://www.harvestofthemonth.com) or by referring to the Resources section on the enclosed CD.

Please visit the following Web sites to order these materials, which are referenced in all of the educator newsletters.

**Fresh Fruit and Vegetable Photo Cards:**
- [www.cde.ca.gov/re/pn/rc/](http://www.cde.ca.gov/re/pn/rc/)

**Fruits and Vegetables Galore:**

**Kids Cook Farm-Fresh Food:**
- [www.cde.ca.gov/re/pn/rc/](http://www.cde.ca.gov/re/pn/rc/)

**School Foodservice Guide – Successful Implementation Models for Increased Fruit and Vegetable Consumption:**
- [www.shop5aday.com/acatalog/School_Food_Service_Guide.html](http://www.shop5aday.com/acatalog/School_Food_Service_Guide.html)

**California 5 a Day Campaign Materials**

Ordering of these materials can be coordinated through your Regional Nutrition Network Project Director. You can also visit [www.ca5aday.com](http://www.ca5aday.com).

- California African American 5 a Day Campaign
- California Children’s 5 a Day—Power Play! Campaign
- California 5 a Day—Be Active! Worksites Program
- California 5 a Day Retail Program
- California Latino 5 a Day Campaign
Acknowlegements

California Department of Health Services’ Cancer Prevention and Nutrition Section (CPNS) would like to recognize the following individuals and organizations for their involvement in the development of the Harvest of the Month tool kit.

Organizations:
California Department of Education (CDE), California Foundation For Agriculture in the Classroom, Farm Bureau Federation, Life Lab Science Program, Produce for Better Health Foundation, Sports Play and Active Recreation for Kids (SPARK), Western Growers Association and California Department of Food and Agriculture

Contractors:
Runyon Saltzman & Einhorn, Inc., Hill and Knowlton, Inc.

Cancer Prevention and Nutrition Section staff:
Desiree Backman (California 5 a Day Campaign Manager), Veronica Davison (Communications and Media), Susan Foerster (Chief, CPNS), Andy Fourney (Research and Evaluation), Tanya Garbolino (Children’s 5 a Day – Power Play! Campaign Manager), David Ginsburg (Assistant Chief, CPNS), Sonia Kuar (5 a Day Retail Program Manager), Hyuni Lee (Community Development), Helen Magnuson (CDE Liaison to CPNS, Nutrition Education Consultant), Susan Magrann (Regional Nutrition Education Coordinator), Jessica Micheletti (California Be Active Campaign), Lawrence Montgomery (Communications and Media), Susan Pennel (Communications and Media Manager), Carole Pirruccello (Community Development Manager), Linda Prescott (Regional Nutrition Education Coordinator), Valerie Quinn (Regional Nutrition Networks Operations Manager), Jackie Russum (Regional Nutrition Education Coordinator), Gil Sisneros (California Be Active Campaign Manager), Terri Soares (Regional Nutrition Education Coordinator), Katharina Streng (Regional Nutrition Education Coordinator), Sharon Sugerman (Research and Evaluation Manager), Kristy Tuttle (Children’s 5 a Day – Power Play! Campaign)

Advisory Panel members:
Steve Baldwin, Hawthorne School District – Nutrition Network Project Director
Deborah Beall, California Department of Education – Nutrition Education Consultant
Julie Brown, Hawthorne School District – Nutrition Network Teacher Advisor
Jan Burkett, Piranha Produce – School Food Service Specialist
Erin Conboy-Heiser, Berkeley Unified School District – Program Coordinator
Judy Culbertson, California Foundation for Agriculture In the Classroom – Executive Director
Tracy Fiscella, Santa Clarita Valley School Food Services Agency – Nutrition Specialist
Anne Gaffney, Elk Grove Unified School District – Nutrition Specialist
Margie Mininger, Lindsay Unified School District – Food Service Director
Lissa Mooney, Los Angeles Unified School District – Nutrition Specialist
Joanne Osborne, Pixley Unified School District – Child Nutrition Service Director
Snook Ripple, Ripple Riley Thomas – Sales and Marketing
Susan Singer, Los Angeles Unified School District – Teacher Advisor
Sandy Van Houten, Ventura Unified School District – Director of Child Nutrition
Bu Wang, Hawthorne School District – Nutrition Network Resource Specialist
To use the enclosed CD, it is recommended that your computer is at least a Pentium II, with 300 mHz and 64 MB RAM.

For step-by-step instructions on how to add logos, menus, phone numbers etc., to the Harvest of the Month elements please refer to the instructions below. Frequently Asked Questions (FAQs) pertaining to utilization of the digital elements are on the enclosed CD.

How to Add Personalized Elements to the Harvest of the Month Tool Kit Materials
All elements on the enclosed CD will automatically open in Adobe Reader. Although not required, this program can be downloaded at no cost from the enclosed CD or by going to www.adobe.com/products/acrobat/readstep2.html.

Adobe Reader will only allow you to view and print the elements. This program is all that is needed if manually (physically cutting and pasting) adding a school logo, phone number, etc. If you would like to digitally (by computer) add a school logo, menu, etc., you must have Adobe Acrobat Standard, Professional or other program that edits PDF documents. These programs can be purchased by going to www.adobe.com.

Manual Personalization
To physically cut and paste a logo onto the documents, please take the following steps:

1. Copy the Harvest of the Month file needed for personalization from the CD-ROM onto the hard drive by opening the CD, selecting the file and saving a copy onto the computer.
2. Double-click on the file icon to open it.
3. Print the document by going to File ➔ Print. All elements can be printed in black and white or color.
4. In the Print window, in the area identified as Page Handling, select Fit to Paper as the Paper Scaling option and check the box next to Auto-Rotate and Center. In the Print What option, select Document.
5. Click OK to print.
6. On the printed Harvest of the Month document, measure the area that is available for the logo (identified on the samples shown on this page).
7. Reduce or enlarge logo to proportionate size, either manually (photocopy) or digitally.
8. Paste the physical copy of the logo on the Harvest of the Month document in the correct position.
9. If the selected copier duplexes (prints 2-sided), load all pages of the Harvest of the Month document and choose the duplexing (1 ➔ 2-sided) option.
10. If the copier does not duplex, print the required number of Page 1, load those pages into the copier paper drawer (based on the copier’s specifications) and print Page 2.
Digital Personalization

Logo and/or menu must be in either .jpeg (jpg) or .tif (tiff) formats. These instructions pertain to Adobe Acrobat Professional Version 6.0, instructions for other versions may vary. Please follow the steps below:

1. Copy the Harvest of the Month file to be personalized from the CD-ROM to the hard drive by opening the CD, selecting the file and saving a copy to the computer.
2. Double-click on the file icon to open it.
3. At the bottom of the screen, click the Next Page to reach the correct page on which to insert the logo.
4. Go to View → Toolbars, select Advanced Commenting.
5. Minimize this screen.
6. a. If using a Mac, go to step 7. If using a PC, go to Start → Programs → Accessories → Paint (this will open the Paint Program). In the Paint program, go to File → Open, browse for the logo and click OK. If Paint isn’t in the Start menu, it can be opened using Start → Run → (type) mspaint and press OK.
   b. Go to Image → Stretch/Skew and in the Stretch area type 50 for both the Horizontal and Vertical percentages, then click OK. Repeat this step until the image is no deeper than the image of the paint bucket on the left and/or no wider than the middle of the word Colors on the top of the menu, whichever is smaller.
   c. Go to Edit → Select All and then go again to Edit → Copy. Go to step 8.
7. a. If using a Mac, double-click on image file to open Preview.
   b. Go to Tools → Select Tool and select image by dragging cursor to create a rectangle around image.
   c. Go to Edit → Copy.
8. Maximize the Adobe Acrobat screen.
9. On the Advanced Commenting toolbar, click on the arrow next to the paper clip icon and select Paste Clipboard Image.
10. Put the cursor in the middle of the area in which the logo should appear and click.
11. If the logo is not in the exact right location, click and hold the mouse button and move the image to the correct position.
12. If the logo is not exactly the correct size, click on the image, go to one of the corners, roll the mouse over the corner until the cursor changes to a double arrow. When that occurs, hold the mouse button down and then hold the Shift key down and move the cursor to either enlarge or reduce the image to the correct size. At that point release the mouse button and the Shift key.
13. Go to File → Print. All elements can be printed in black and white or color.
14. In the Print window, in the area identified as Page Handling, select Fit to Paper as the Paper Scaling option and check the box next to Auto-Rotate and Center. In the Print What option, select Document.
15. If the selected printer allows 2-sided printing, choose that option and print the required number of copies. If not, print one copy of the document to use for photocopying.
16. Click OK to print.
17. If the selected copier duplexes (prints 2-sided), load all pages of the Harvest of the Month document and choose the duplexing (1 → 2-sided) option.
18. If the copier does not duplex, print the required number of Page 1, load those pages into the copier paper drawer (based on the copier’s specifications) and print Page 2.

Harvest of the Month materials are copyrighted, but may be reprinted for educational purposes.
CD Contents

Monthly Elements*
- By Month
- By Elements
*For the monthly Featured Produce list, please refer to page 4 of this guide, the enclosed CD or www.harvestofthemonth.com.

Supplemental Materials
- Links to Supporting California Content Standards
- Featured Produce List (Cycles I, II and III)
- Fact Sheets (Local and State)
- Answers to Student Sleuths
- Taste Testing Tips
- Rate the Taste (sample taste testing activity)
- Safe Food Handling Techniques
- How Much Do I Need? (nutrition recommendations for kids)
- What’s on a Label?
- Botanical Illustrations
- Harvest of the Month Letterhead
- Sample Forms

Resources
- Literature Links
- Nutritional Information
- National Cancer Institute Recipe Criteria
- List of Web-based Resources
- Regional Nutrition Networks Contact List
- Teacher Tips
- Cooking Cart

Ordering Information
- List of Collateral

Help Section
- FAQs
- Technical Support